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1 Introduction 
Windscreen 2T Modeller (WIS 2T) is a software tool to assist in the design of heated 
windscreens for aircraft and locomotive applications. It can also be used as a more general tool 
for calculating the thermal properties of unheated glazings. WIS 2T brings together two separate 
design functions into one software package: 
 Anti-icing performance 

WIS 2T predicts the power density requirements for anti-icing with electrically heated 
windscreens in accordance with the method described in Ice, Rain, Fog, and Frost 
Protection: SAE AIR 1168/4. This covers both anti-icing (external surface) and anti-
fogging (internal surface). It also includes an option to run the analytical modelling 
described by George C Letton Jnr in his published paper from AFML-TR-73-126: 
Conference on Transparent Aircraft Enclosures; Las Vegas; 1973. 

 Thermal performance 
WIS 2T predicts the steady-state and dynamic temperature distribution throughout a 
coated laminated windscreen based on user-definable environment and boundary 
conditions. The mathematical model uses a 1D mesh approach, solving the heat 
transfer linear equations using the tri-diagonal method. 

 
WIS 2T is designed and written to run on a modern pc platform with the following minimum 
requirements: 

 Processor speed:  >2 GHz;  Intel Pentium or equivalent  Available RAM:  >256MB  Available Disc space: > 100 MB  CD Reader:  >48x  Screen Resolution > 1024 x 768 
 
WIS 2T relies on a number of system and supporting software being installed on the pc platform, 
as follows: 

 Operating system:  Microsoft Windows (8, 7, Vista or XP)  Enabled software:  Microsoft .NET Framework version 4.0 or higher  Enabled software: Microsoft Internet Explorer version 6 or higher  
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2 Software Installation 
WIS 2T is supplied as a CD with a number of USB license dongles. The contents of the CD are 
not protected and can be freely copied and distributed.  
The CD contains all the files necessary to automatically install and operate the software on a pc 
platform as specified in Section 1. After installation, the USB dongle is required to enable any 
calculations to be performed. Without the USB dongle in place, the software will operate but not 
perform any of the mathematical modelling available. 
IMPORTANT: DO NOT install the USB Key before the installation of the WIS 2T 
software 
IMPORTANT: UNINSTALL any existing versions of WS or WIS Modeller software before 
installing or re-installing this WIS 2T software 
 
To install the software, insert the CD into the disk drive. The AUTORUN feature will 
automatically install the program and load the associated files on the computer. This will copy all 
the required resources into the Programs File Directory on the main hard disk drive. The 
application is called WIS Modeller 2T. 
The installer software will also create a Start Menu entry and also set up a desk-top icon called 
WIS Modeller to launch the application.  
When the application is first launched, it will create a WIS Modeller directory in the user’s home 
account. This directory will create all permanent and temporary data files, such as materials 
libraries, needed during the operation of the application. 
All files created or accessed by the application software are not encoded or protected. Since the 
data structure within the files are fixed format, bespoke to the software, it is not advisable to 
manually alter their contents. Editing or manipulating these files manually, could result in 
software instability, incorrect functionality or the production of erroneous results.  
To uninstall the software, select the uninstaller application in the WIS Modeller folder in 
Program Files. This will remove the program and all its associated files, leaving only the data 
files residing in the user’s home directory. 
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3 Using the Software 
3.1 Main Menu 
WIS 2T software is organised in standard Microsoft Windows format and the main functions are 
provided along a menu bar at the top of the screen, as shown below.  

 
 
Functions from the Menu bar include: 
File Edit Analyse Materials Help 
New 
Open 
Save 
Save As 
Exit 
 

Cut 
Copy 
Paste 

Show Design panel 
Show Analysis panel 
Environmental 
Parameters 
Import User Search 
Analyse Windshield 

Open Material 
Library 
Re-load Material 
Library 
 

About 
Tabbed Results 
SAE AIR 1168/4 
AFML-TR-73-126; Letton 

 
The Icons shown below the Menu bar are shortcuts to the Menu options. For the definitions, refer to 
Annex 1: Quick Reference Guide. 
Selecting any of the available options under the Help menu requires a programme exit and re-start 
before the change is effective. 
Selecting and de-selecting “Tabbed Results” switches the Analysis panel display between the default 
twin-pane format and a tabbed format, with larger displayed graphs. The twin-pane format is used 
throughout this User Manual. 
SAE AIR 1168/4 and AFML-TR-73-126; Letton are mutually exclusive and only one calculation 
method can be selected. The default is SAE AIR 1168/4. 
 
TIP: Several Hot Keys and Icons are provided to allow quick navigation throughout the software. A 
quick reference guide to these is provided in Annex 1. 
CAUTION: The Edit menu options are not available in WIS 2T. 
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3.2 Design Panel 
After the application software is launched, the Design panel, shown below, is displayed by default. 
This is the main working area for constructing the windscreen by layers and busbar geometry, prior to 
performing the calculations and analysis. 

 
 
The design screen is divided into four (4) main areas: 
Materials: This area lists the materials available for constructing the windscreen design.  

Bulk materials, such as Float Glass, are shown in black. 
Heating film materials, such as ITO, are shown in red. 
Other coatings are shown in blue. 
 

Layers:  This area details the construction of the windscreen design as it is being prepared. 
It provides an editing function for deleting or re-ordering layers after they have 
been created. 

Cross section: This area shows the windscreen construction in cross-section in a pictorial fashion. 
This cross-section picture will be used in the analysis. 

Installation: This area is for entering the windscreen installation parameters and wettedness 
factor as used by SAE AIR 1168/4 (and also by Letton). It provides a conversion 
facility to allow entry in either metric or imperial units. 
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3.3 Analysis Panel 
The Analysis panel, shown below prior to any modelling, is the main working area for viewing the 
results of the mathematical modelling calculations.  

 
 
There are two (2) main areas presented after the analysis is completed: 
Anti-icing 
performance: 

This area presents graphical information on the calculated power density 
required for preventing icing on the outer surface. It calculates and searches 
through both continuous maximum icing or intermittent maximum icing 
envelope conditions, as provided by FAR Par 25 Appendix C. The 
calculations are performed in accordance with SAE AIR 1168/4 or AFML-
TR-73-126; Letton, whichever is selected. 

Temperature 
performance: 

This area presents the calculated temperature at each interface at a given 
time overlaid onto a 1-D cross-section of the windscreen construction. The 
initial result presented is the steady state condition. Information on the 
Internal and External heat transfer coefficients, Dew point temperature, inner 
and outer surface conditions is also provided. 
The calculated temperatures at each interface as a function of time can also 
be displayed in this area.  
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4 Designing a Windscreen 
 
A description of all the software function and features is provided through the use of an example 
throughout this Section and Section 5.  
In this section we will design a typical aircraft windscreen construction and shape that might be used 
for a large commercial jet. The construction is as follows: 

1 3mm Float Glass outer face-ply 
2 Anti-icing coating of ITO on inner surface of face-ply, with operating values of: 

 7,000 KW/m2 power density  
 40°C control temperature 

3 2mm Polyurethane interlayer 
4 10mm Float Glass main-ply 
5 1.5mm Polyurethane interlayer 
6 10mm Float Glass inner-ply 

 
4.1 File Menu 
Selecting the File pull-down menu will produce the following option list: 

 
 
4.1.1 New Windscreen 
 
Select this option for constructing a new design when existing data needs to be cleared. A dialogue 
box will appear in the centre of the screen. 
4.1.1.1 New Windscreen Dialogue Box 
Requires the user to confirm that deletion of current data is acceptable. This message will appear 
anytime the user selects an action that could potentially lose data that has not been saved. 
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4.1.2 Open Windscreen 
Select this option to retrieve a previously saved windscreen design. A dialogue box will appear in the 
centre of the screen. 
4.1.2.1 Open Dialogue Box 
Requires the user to select a *.wsm file from a list. The default directory is User/<username>/WIS 
Modeller/data and wsm is the default file extension. The user can navigate through file directories in 
normal Microsoft Windows format. 
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4.1.3 Save Windscreen 
Select this option to save the current windscreen design. A dialogue box will appear in the centre of 
the screen. 
4.1.3.1 Save Dialogue Box 
Requires the user to select a filename for the design to be saved. The *.wsm file extension is used the 
default and the default directory is User/[username]/WS Modeller/data. The user can navigate through 
file directories in normal Microsoft Windows format. 

  
 
 
4.1.4 Save Windscreen As 
 
Select this option to save the current windscreen design with a different filename from the current 
filename. The “Save As” dialogue box will appear in the centre of the screen. Other than the title 
“Save As”, the dialogue box is identical to one described above. 
 
 
 
For our example, select “New windscreen” from the File menu. Click Yes to continue 
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4.2 Selecting Material Layers for a Windscreen Construction 
 
Enter a layer by selecting a material from the list in the Materials area using the mouse and then 
clicking on the “Add this Layer” button below the list. The Layer properties dialogue box will appear 
in the centre of the screen. 
TIP: Materials are colour coded:  

 Bulk materials, such as Float Glass, are shown in black.  Heating film materials, such as ITO, are shown in red.   Other coatings are shown in blue. 
4.2.1 Layer Properties Dialogue Box:  
The Layer Properties dialogue box allows the user to set the basic parameter variables for the 
particular layer in the construction. The values that can be adjusted will depend on the material type. 
 

 
 
For bulk materials, enter the thickness of the layer in MILLIMETRES (mm) and click OK when 
complete. 
For a heating layer of ITO, enter the layer thickness in NANOMETRES (nm), then enter the power 
density and the control temperature parameter values in KW/m2 and °C respectively. Click OK when 
complete. 
CAUTION: Take care to use the correct thicknesses and dimensions 
The layers will build up in the Layers area and Cross-section area. Once the layers have been added to 
the construction, they cannot be edited. To effect a change, the layer needs to be deleted and then re-
added correctly. 
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4.2.2 Layer Order and Delete Icons 

 
Select a layer in the Layer area and select the green arrows to move this layer up and down on the 
order of the windscreen construction. Use the red cross to delete the selected layer. 
TIP: If the parameter values for any of the layers in the construction are incorrect or need to be 
changed, use the red cross to delete the layer and re-add the layer with the correct parameter values. 
Then use the green arrows to put the new (changed) layer in the correct place. 
 
 
In our example, we select Float Glass first and “Add this layer”. This opens the Layer properties 
dialogue box. Enter 3 for the Thickness, then click OK. This will now be confirmed in the Layers area 
and the Windshield cross section will be filled.  
Select the second layer, in our case the anti-icing coating, ITO and “Add to this layer”. Enter 300 for 
the Thickness, then 7000 for the Power Density and 40 for Control Temperature.  
 

 
 
 
Continue to select the subsequent four (4) layers of Polyurethane, Float Glass, Polyurethane and Float 
Glass, in sequence, completing the Layer Properties dialogue box for each of the layers of the 
windscreen construction. For our example this will look like: 
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4.3 Windscreen Installation 
 
Moving over to the far right of the upper working area on the design screen, this is where the 
windscreen installation parameters are set. This information is required for the SAE AIR 1168/4 (and 
AFML-TR-73-126; Letton) calculations. There are five (5) values required and default parameters are 
provided. These are: 
 
Parameter Description 
Half Height 
Stagnation Distance  
 
Inclination Angle 
Swept Angle            . 
 
Wettedness Factor     

The average height of the windscreen divided by two (2).  
The distance from the nearest stagnation point (generally the nose of aircraft) 
to the centre of the heated windscreen area.  
Angle of the windscreen to the undisturbed free-stream ahead of the aircraft. 
Angle of rotation of the base of the windscreen from the perpendicular to the 
undisturbed free-stream ahead of the aircraft. 
The Surface Wettedness, values between 0 and 1, where 1 is completely wet.  
Normal values are: untreated glass = 0.4; acrylic = 0.2.  
Note: Setting this value to 0 under AFML-TR-73-126; Letton, enables the 
Wettedness factor to be calculated in accordance with this analytical method. 
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A check box is provided to allow entry of the values in either metric (checked) or imperial 
(unchecked) units. This is provided because SAE AIR 1168/4 and FAR Part 25 Appendix C (and 
AFML-TR-73-126; Letton) normally use imperial units. The consequential effect of the change of 
units is automatically passed forward, the units are updated on the panels and the calculations 
converted accordingly.  
 
TIP: Checking and unchecking the metric box will perform the conversion for the user. 
 
A pictorial description is provided below for further clarity. 
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4.4 Analyse Menu 

 
4.4.1 Show Design Panel 
Changes the current view to the Design panel. 
4.4.2 Show Analysis Panel 
Changes the current view to the Analysis panel. 
4.4.3 Environmental Parameters 
Displays the Environmental Parameters dialogue box to allow the user to change the default 
settings. 
4.4.3.1 Environmental Parameters Dialogue Box 
 

 
In this dialogue box the environmental conditions are set defining the assumption and boundaries for 
the analysis. There are eighteen (18) parameter variables that need to be set, unless the default is 
acceptable, and a further three (3), if information is available on the flight deck, to perform the de-
fogging calculation as exampled in SAE AIR 1168/4. WIS 2T also provides the option to set the 
interface temperatures of the windscreen for the start of the analysis in the Initial Block Profile area. 
Values are set by clicking on the number in the appropriate box and typing in the desired number or 
selecting the increase/decrease buttons by the right hand side of the number. 
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Internal 
Conditions 

Temperature The ambient internal air temperature (either °C or °F) 
Transition time The time taken for the temperature to rise from the Block Temperature to the 

ambient internal temperature. This provides the user with a first level 
approximation for the use of cabin air conditioning (seconds) 

Hi The internal heat transfer coefficient at the external surface of the windshield 
(either W/m2 or BTU/(hr.ft2.°F)). 

Relative 
Humidity 

The relative humidity on the flight deck as a fraction of 1 (ie 0.6 = 60% RH). 
If RH is set to 0, the calculation will use values for crew number, flight deck 
airflow and pressure altitude.  

Crew number The number of crew on the flight deck. 
Flight Deck 
Airflow 

The circulating mass airflow on the flight deck (either Kg/s or lbs/min). 
Flight Deck 
Pressure Altitude 

The effective pressure altitude on the flight deck (either metres or feet). 
External 
Conditions 

Temperature The ambient external air temperature (either °C or °F) 
Ho The external heat transfer coefficient at the external surface of the windshield 

(either W/m2 or BTU/(hr.ft2.°F). 
Altitude The altitude of the aircraft (either m or feet). 
Velocity The velocity of the aircraft (either m/s or knots (True Air Speed)). 

Analysis 
Options 

Analysis time The total time period for the Dynamic Temperature analysis (seconds). 
Time step The time interval between each calculation of the temperatures at the 

interfaces (seconds). 
Frequency The time interval between the graphed or tabulated results at the interfaces 

(seconds). 
Mesh Length The basic distance between each calculation position within the block (mm) 
Metric This check box is provided to allow entry of the values in either metric 

(checked) or imperial (unchecked) units. This is provided because 
SAE1168/4, FAR Part 25 (Appendix C) and AFML-TR-73-126; Letton 
normally use imperial units. The consequential effect of the change of units is 
automatically passed forward, the units are updated on the panels and the 
calculations converted accordingly.  

Transient 
Options 

Initial 
Temperature 

Sets the initial temperature to allow for a linear change in either, or both, the 
outer and inner ambient temperatures, if desired. Default is the same values 
for outer and inner as Internal and External temperatures (°C or °F). 

Final 
Temperature 

Sets the final temperature for the linear change. Default is the same values for 
outer and inner as Internal and External temperatures (°C or °F). 

Transition Time Time taken for the linear change from intial to final, if desired. Default is 
zero (0) (seconds). 

Initial 
Block 
Profile 

Block 
Temperature 

Defines the temperature of the block at time zero for the dynamic calculation. 
Assumes the windscreen is in equilibrium with the ambient temperature, 
which itself is the same both internally and externally (°C or °F). 

Set Interface 
Temperatures 

Allows the interface temperatures to be defined individually (°C or °F).  
 
In our example, these parameter values have been left as the defaults. 
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TIP: Checking and unchecking the metric box will perform the conversion for the user. 
TIP: Data entry for the interface temperatures is free format. Once the Set Interface Temperatures is 
clicked, WIS 2T will check the correct number of interface temperatures has been entered and present 
the data in a column. 
 
4.4.4 Spot Calculation 
Displays the Spot Calculation dialogue box to allow the user to change the default settings. 
4.4.4.1 Spot Calculation Dialogue Box 
 

 
In this dialogue box the environmental conditions are set for a single calculation for the analysis, as 
opposed to a search and hence the term Spot Calculation. There are five (5) parameter variables that 
need to be set. 
Ambient Temperature 
 

The ambient external air temperature (either °C or °F). 
Altitude 
 

The altitude of the aircraft (either m or feet). 
Velocity 
 

The velocity of the aircraft (either m/s or knots (True Air Speed)). 
Droplet Diameter The appropriate droplet diameter (in microns) for the temperature and  

altitude and whether maximum, mixed, periodic or continuous icing 
conditions 

Liquid Water content The appropriate liquid water content,  LWC, (in g/m3) for the 
temperature and  altitude and whether maximum, mixed, periodic or 
continuous icing conditions 

Metric This check box is provided to allow entry of the values in either metric 
(checked) or imperial (unchecked) units. 
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Values are set by clicking on the number in the appropriate box and typing in the desired number or 
selecting the increase/decrease buttons to the right hand side of the number. 
Any changes to any of the above parameter values will instigate a new SpotCalc automatically and the 
new calculated heat losses will be shown in the area above the Calculate button as shown below 
 

 
 
Click OK or  to close this dialogue box. 
 
TIP: Checking and unchecking the metric box will perform the conversion for the user. 
 
4.4.5 User Defined Icing Conditions 
Allows the User to define a bespoke set of search conditions and import these from a spread sheet into 
WIS 2T. This facility is currently at Beta phase and particular care is required to ensure the data is 
loaded correctly. 
The structure of the spreadsheet is predefined and an example is provided below. 
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Notes for the Beta phase:  
 The limits of the table are set and not extendable; 
 The cell positions are fixed, any changes will result in failure to read the data correctly; 
 The units are not switchable and must be entered in the specified units; 
 The ambient temperature must go across the spreadsheet in descending order;  

Once the spreadsheet is correctly populated with the desired search parameters, click on Import User 
Defined icing conditions to open the spread sheet as shown below. 

 
The software will respond with a message once the data is loaded, shown below. Click OK to 
proceed. 

 
 
 
4.4.6 Analyse Windshield 
 
Select the Analyse Windshield function to run the calculations and execute all mathematical models 
based on the data entered. As all the necessary parameter variables will have values, either set by the 
user or the defaults, all three mathematical models will produce results and automatically display 
them in the Analysis panel. 
CAUTION: Ensure that all the parameter variables have been changed from the defaults where 
required. Check these in the Thermal, Optical and Grading dialogue boxes if uncertain. 
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5 Analysis of a Windscreen  
 
In this Section, the results of the analytical calculations for the example windscreen described in 
Section 3 are given. On selecting the Analyse Windshield action, as described in section 3.4.6 above, 
the results are shown on the Analysis panel. The analysis result for our example is shown below: 

 
 
This display is the Quad format. If “Tabbed Results” has been selected under the “Help Menu”, the 
analysis results for our example will be presented in the tabbed format as shown below, with three (3) 
Tabs along the bottom of the Analysis panel: 
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5.1 Analysis Area Icons 
Each of the four (4) display areas has the following action icons: 

 
5.1.1 Save 
This icon saves the current results graph as a *.png file in the default, or last used, directory. 
5.1.2 Print 
This icon prints the current results graph to the installed printer choices on your computer. 
5.1.3 Restore 
This icon will activate the restore function and return the graph displayed to its original sizing. 
5.1.4 Expand 
This icon will expand the current results graph to be expanded to full screen on a new panel. 
TIP: The expanded panel for Steady-State Thermal Performance, provides additional information 
above the chart, as exemplified below:       

 
5.1.5 Export CSV 
This icon allows the user to export tabular results data from the calculation. Clicking this icon will 
open a Save dialogue box with the default File Type Comma separated value (*.csv), as shown below: 

 
 

TIP: Expanded panels maintain the action icons described above. To close an expanded panel simply 
click on the  in the top right hand corner. 
 
5.2 Graph Functions 
The graphical displays have sizing, re-scaling, datapoint information as well as graphical text 
formatting. By right-clicking in the graphical area, a menu is provided, as shown below. 



WIS Modeller 2T Software……………………………………………………………….User Manual 

Page 23 of 31 

 

 
 
These are standard options and self-evident, so the details of these options are not described here. 
However, the following two tips are exampled below: 
(a): Click and drag to define the area for zoom. On releasing, the chart will re-size to that area. 
 

 
 
TIP: To return to the original sizing click on  button 
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(b) Click near a point of interest and intercepts will be provided defining the x and y positions. Hover 
at that point and the data point details will appear temporarily. 
  

 
 
5.3 Anti-Icing Performance 
The Anti-icing results are shown in the left hand side. The software calculates the power density 
required for an external surface temperature of 1.7 °C (35 °F) and performed a search for the 
maximum power required.  
The search covers approximately 11,500 scenarios for each of Continuous (Stratiform Clouds) and 
Intermittent (Cumuliform Clouds) maximum icing conditions, varying aircraft speed (50 to 450 knots 
(TAS)), altitude (0 to 22,000ft), external temperature (-22 to 32 °F), mean droplet diameter (15 to 50 
microns) and liquid water content (0.04 to 0.8 and 0.09 to 2.9 g/m3, respectively) as constrained and 
defined within the icing conditions described in FAR Part 25 Appendix C. 
If a search over a user-defined set of icing conditions has been set up (see 4.4.5) these are also 
calculated and presented here. 
The results are shown graphically and are automatically selected to show the set of parameter 
variables requiring the maximum heat flow to prevent icing. The output automatically chooses 
different colours and a legend for each curve is provided at the bottom of the chart. 
The radio buttons allow the user to select between Continuous Maximum Icing Conditions, 
Intermittent Maximum Icing Conditions and user-defined Icing Conditions.  The analysis for our 
example, expanded to full size mode, is shown below. 
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5.3.1 Continuous Maximum Icing Conditions (FAR Part 25 Appendix C) 
 

 
 
The Temperature and Altitude pull-down menus allow the user to select a results chart for different 
conditions. By definition these will always give lower power requirements than the initial chart that 
was automatically selected. The maximum power density requirement for all conditions, is shown as a 
dashed horizontal line on all charts, regardless of the Temperature and Altitude selected. 
Note: Charts are not calculated for Temperatures and Altitudes that are not in the icing envelopes. 
5.3.2 Intermittent Maximum Icing Conditions (FAR Part 25 Appendix C) 
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5.3.3 User-defined Icing Conditions 
 

 
 
5.4 Thermal Performance 
The thermal performance is shown in the top right hand quadrant. In this area there are two tabs: 
Steady-state and Dynamic.  
5.4.1 Steady State Thermal Performance 
The analysis for our example has provided the following steady-state temperature distribution based 
on the parameter values set in Section 3. This graph has been expanded to full size mode.  
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In addition to the action Icons described in Section 4.1 above, this result panel includes a slider bar, 
allowing the user to select and look at the temperature distribution at any of the time intervals during 
the analysis. 
Additional information is provided in this panel: Ice free, Fog free, Ho, Hi and Dew Point. Note the 
Ho value in this case has been calculated, because the variable was set to zero in Section 3.5.3.1.  
The  icons indicate that the external surface is above 1.7 °C (35 °F) and the 
internal surface is above the Dew point temperature. In the event that either or both are below these 
values, the icons will turn red and indicate risk, as exampled here:  or

. 
TIP: Hovering the cursor over any of the curves will display the (x,y) coordinates at that point, as 
shown in the example figure above. 
CAUTION: The heater layer is not annotated in this cross section. Only the bulk materials are 
annotated. 
 
5.4.2 Dynamic Thermal Performance 
The analysis for our example has provided the following dynamic temperature distribution based on 
the parameter values set in Section 3. This graph has been expanded to full size mode 
 

 
 
This graphical output automatically chooses different colours for each curve and a legend is provided 
identifying the curves. Each curve represents an interface and the labels reflect the distance of that 
interface from the front surface. 
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6 Materials Library 
WIS 2T is supplied with a range of common materials used in manufacture of aircraft windshields. 
The properties of these materials have been sourced from public domain sources and are available via 
the internet.  
This data is stored in an XML format file called materials.xml which is automatically saved in the 
user’s directory when the WIS 2T software is installed. For example,  
C:\Users\<Username>\WIS Modeller\config.  
The Materials function allows the user to edit the current material data and add new materials. 
Selecting the Materials pull-down menu will produce the following option list: 

 
 
6.1 Open Material Library 
Select this option for editing and adding new materials to the material database. Unlike the other 
menu selection options, a dialogue box will not appear. Instead, WIS 2T will open a new tab in your 
browser as shown below: 

 
 
The materials available in the Material Library are shown in the column on the left and the data stored 
is shown in the centre of the screen. WIS 2T requires the physical thermal data to be present (Density, 
Specific Heat Capacity and Thermal Conductivity). WIS 2T does not require the Optical data to be 
present. The optical data is required by other versions of WIS Modeller in the series and these use the 
same central materials library. 
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6.2 Editing Existing Material Data 
To edit data, simply overwrite or add additional entries in the same format, ensuring that the data 
entered is in the correct units. 
Once completed, click on the save button. 

 
CAUTION: WIS 2T does not use the Download and Delete functions. 
CAUTION: The edited data becomes resident in the materials library when save is clicked. The 
new data becomes available to WIS 2T either through the Reload Material Library option or on 
closing and re-starting WIS 2T. 
 
6.3 Adding New Material Data 
To add a new material, click on the  button to produce the following sub-menu. 

 
 
Click on the appropriate material type for the new material. For example, ITO would be a heating 
film. Populate the blank entries with the appropriate data in the correct units. In the example below, a 
bulk material is being added. 
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Once completed, click on the save button. The Materials list will now be updated. 
 
Tip: Use the browser refresh button to ensure the latest data is available after entering new materials.  
CAUTION: WIS 2T only uses the save function. Download and delete are not used. 
CAUTION: The edited data becomes resident in the materials library when save is clicked. The 
new data becomes available to WIS 2T after either selecting the Reload Material Library option 
or on closing and re-starting WIS 2T. 
 
6.4 Reload Material Library 
 
Select this function to use any edited or new data. 
Since the materials library is independent of the WIS 2T software, once any changes have been made 
to the materials library, it must be re-loaded using this function for the edited or new data to become 
available for modelling. 
Closing and re-starting WIS 2T will automatically load the last saved version of the Material Library. 
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 ANNEX 1:  Quick Reference Guide 
 
Function Icon Hot Key Description 
New Windscreen  Ctrl-N Start new windshield design. Clears existing data 
Open Windscreen  Ctrl-O Retrieve and open windshield design from file 
Save Windscreen  Ctrl-S Save windscreen design to file with existing file name 
Save Windscreen as   Save windscreen design to file with the opportunity to change file name 
Show design panel 

 
Ctrl-D Move from current screen to Design panel 

Show analysis panel  Ctrl-R Move from current screen to Analysis panel 
Thermal Properties  Ctrl-T Enter or amend the Thermal condition parameter variables 
Analyse Windshield  F8 Run the mathematical models and performs the calculations 
Print   Print the current chart 
Resize    Return the chart to the original size 

Maximum size   Maximise the chart size on the screen 

Export Data    Export data to a CSV file. Facility can be used for tabulated results. 
 
  


